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1 Scope

1.1 Purpose of Document

This document is a supplement of the installation manual with PROFIBUS PA secific items.

=  This document ...

1.2 Applicable Documents

This document should be read in conjunction with the following documents:

Ref. Title

| File name | Version

[1]

[2]

[3]

[4]

[5]

Table 1-1 : Applicable Documents




2 Application Guide SIMATIC STEP 7

2.1 Necessary equipment

You need following equipment to use SIMATIC Manager with STEP 7:
- PROFIBUS PA instrument (DUT)

- PROFIBUS interface (e.g. CP5611 or CP5612)

- SIMATIC S7-300 (e.g. CPU315-2DP)

DP/PA-coupler (e.g. Pepperl+Fuchs KFD2-BR-Ex1.PA)

- SIMATIC Step 7 ver. 5.2 (SP1) or higher

- PC or laptop

PCPG (CP5611)
with SIMATICSTEP7

S
s
=
B

§7-300

bus termination

optional PCPG (CP5611)
with SIMATICPDM

i

_

bus termination

line termination

line termination

PROFIBUS

PA device
(e.9.P7xxx )

Figure 1: HW structure DP/PA

While every effort was made to verify the following information, no warranty of accuracy or
usability is expressed or implied.

2.2 Overview

SIMATIC S7 is a Siemens PLC. It is used with the software STEP 7. Tools for configuration,
diagnosis and commission are integrated in STEP 7.

The SIMATIC S7-300 family offers the automation solutions for the lower and middle
performance range. Extensive diagnostic possibilities with help from STEP 7. Error
message buffer with time stamp and module diagnostic help the user during error searching.
The PROFIBUS serves as a connection from field devices such as distributed I/O or drives
with automation systems like SIMATIC S7. The PROFIBUS is a performance capable,
assembly and open field bus system. It enacts over quick reaction times, an open interface

and is applicable in different protocol variants.



The PROFIBUS-PA is the inherently safe type of the PROFIBUS, specified for data
transmission in explosive fields (i.e. chemical industry).

An extensive product pallet for the protocol variants is available for the connection to the
PROFIBUS. The configuration and programming takes place over the software STEP 7,
where extensive diagnostic possibilities are available to the user.

2.3 Set the PROFIBUS DP interface card

You can use the PROFIBUS interface cards CP5611 for desktop computers or
CP5511/CP5512 for laptop computers (PCM/CIA). After installing the card in the computer
open the SIMATIC manager and click options. Choose “Set PG/PC Interface” and highlight
CP5611, 5511 or 5512 (MPI).

Set PG,/PC Interface |

Access Path |

Access Point of the Application:
IS?EINLINE [STEF 7]  --» CPREETT[MFI) j
[Standard far STEF 7]

Interface Parameter dszignment | sed:

|CPEG11IMPI)

B <MNone> Diagnostics... |
CPEETT [Euta)

CPEETTIFwWL) Copy... |
CPEE11(MPI) Delete

B CPSE11[PROFIBUS) 4|

[Parameter assignment of your
communications proceszor CPBE1T for an

i Propetties...

MP network]

Interfaces

’7 Add/Remowve; Select... |
el | v |

Figure 2: Set PG/PC Interface

2.4 Integration GSD-File in SIMATIC S7

In the HW Config view you can import a new GSD-File. The GSD-File will be checked
before it build in the HW catalogue of STEP 7.

If you not have created a project before, you must do this first, before you can install a new
GSD-file or overwrite an existing. Otherwise change in an existing project to the “HW Config
window” and proceed with figure 5.



=18 ]

File PLC Wiew Options ‘Window Help

‘Mew Project’ Wizard, ..
Cpen... Chrl+0
Open Yersion 1 Project...

57 Memory Card 3
Memary Card File 3

Delete, ..
Reorganize. ..
Manage...

archive. ..
Rekriewve. ..

Page Setup, ..
Labeling fislds. . .
Prink Setup...

1 neu (Projekt) -- D:\Projekteineu

2 57F_15302_iso (Project) -- D:\ProjekkelS7F_1530

3 MSLe00_DP_production (Project) -- D:\PrajekteiMSLE00_D
4 M3Le00_DP (Project) -- D:\ProjekkeiMSLe00-~1

Exit Ale+F4

Creates a new project or a new library,

Figure 3: Create a new project
Click “File” > “New...” to create a new project (you must choose a project name, e.g.
“new”) and choose your SIMATIC station with “Insert” > “Station”.

§‘51MATIE Manager - [new (Component view) - D:%Projekte’new] - IEI|§|

%File Edit | Insert PLC Wiew Options “Window Help 18] x|

BT Station 1 SIMATIC 400 Station - 5 | | | | |
D Sune » BEEEEE - | NoPher) Jil £ 2=l EI

Program L3 3 SIMATIC H Station
J— N 4 SIMATIC PC Station
e 5 5 Other station
[7. Saftware r & SIMATIC 55
7 PGIPC
Symbol Table
Tiexk library: 3
Extetnal Saurce. .
Inserks SIMATIC  S[aaTIc PO ¥ positian, S

Figure 4: insert SIMATIC station

Switch in the “HW Config view” by clicking the “SIMATIC 300(1)” and double-click at
Hardware.

&ISIMATIE Manager - [new (Component view) -- D:"Projekte’new] i ] 4
@ File Edit Insert PLC Yiew Options Window Help — |ﬁ' |i|

[< Mo Fiter > 1| = 2=m| |

E Hardware

Press FL to get Help, |CP561 L{PROFIBS) v




Figure 5: SIMATIC manager [new...]
Now you must close the window SIMATIC 300(1) (Configuration) — window to insert a GSD.

HW Config - SIMATIC 300(1) =1olxi
Station Edit  Insert PLC  Wiew Options ‘Window Help

D[[5-2 %] & e il @] %28 »l

Al SIMATIC 300{1) {Configuration)} - new Prafile IStandard j

-5 PROFIBLS DP

+-F PROFIBUS-PA

SIMATIC 300

; SIMATIC 400

=-Fl] SIMATIC PC Based Control 200,400
H-f8 SIMATIC PC Station

f<
FROFIBUS-DF slaves for SIMATIC 57, J
M7, and C7 [distributed rack)

Press F1 ko get Help, ’_ A
Figure 6: HW Config — SIMATIC 300

Click “Options” - “Install New GSD...”, choose the GSD-file you want to install.

¥ Config: Configuring hardware - IEIliI

Station PLC  Wiew | Options Help

Ol 9”' d q Zuskomize, ..

Edit Catalog Profile
Update Catalog

Ctrl+alk+E

Erafile I Standard j

Install Hw Updates ... FROFIELS DF
552 PROFIBUS-PA
Impork Station G30... SIMATIC 300
SIMATIC 400

SIMATIC PC Bazed Contral 300400
B SIMATIC PC Station

i
FROFIBUS-DP slaves for SIMATIC 57, J
M7, and C7 [distributed rack)

Installs new GSD Files in the system and updates the contents of the catalog. =
Figure 7: Install New GSD

You can install the manufacturer specific gsd with Ident number 0x0A96 or the standard PA gsd
(with ID-number 0x9750).




Install GSD Files x|

Inztall GSD Files: Ifrom the directary j
|.~’-'«:\ Browse ... |
File Release Yersion
Fa139700.gzd Drefault
1] | i
PP
| riztall | Show Log Select All Dezelect All

|

Figure 8: Example for file “DST0A96.gsd”

Install GSD file {13:4986) x|

& The inztallation was completed successfully.

Figure 9: Message after successful installation

After this you find the device in the HW catalogue depending on the GSD-settings.



[ HW Config - [SIMATIC 300{1) (Configuration) — new] N [=] 3
Eﬂ] Station Edit Insert PLC Wiew Options ‘Window Help =1

D[ 5" |5/ S CEE=E

= o
Find: | ﬂlﬂl

Brafile: I Standard j

=¥ PROFIBUS DP B
=88 PROFIBUS-P4
D Actuators
Your new - Converter
device in the
catalogue
4| | ’

Univerzal module
Analog Input [&l)shart
Analog Input [&l]long
Analog [nput [&l]long

:|:| SIMATIC 300(1)

Slat | Designation

& Paz00
B Fositioner 3785
@ Prosonic T M
1| | B
T
Press F1 to get Help. 5

Figure 10: HW Config — HW catalogue

2.5 Create a new project with STEP 7

To create a new Step 7 project from the SIMATIC Manager window, use the wizard “New
Project” which will guide you through the necessary steps.
Click “Next” to create your project step-by-step.

STEP 7 Wizard: "New Project™ x|

‘% Introduction 104]

STEP T wizard: "Hew Project"

You can create STEP ¥ projects quickly and easily using
the STEP 7 Wizard. %ou can then start programiming
immexiztely.

1 Click one of the fallowing options:
"Mext" to create your project step-by-step

"Finizh" to create your project according to the previesy,

[~ Displary Wizard on starting the SIMATIC Manager: Previg== |
P
< Haek | Ment = 4 I Finizh | Cancel | Help |

Figure 11: STEP 7 wizard “New Project”

First choose the CPU you are using



STEP 7 Wizard: "New Project™ x|

i] Which CPU are you using in your project ? 204
CPU: CPU Type Order Mo I ;I
CPUZI4C-2PtP BEST 314-EBFO0-04ED
CPUHS BEST 315-14F03-0480
CPLI315-2DP BEST 3152861 0-0450 [
CPU316-2 DP BEST 316-28G00-0AE0
CPU318-2 DP BEST 318-28J00-04E0
oA T 4 FREST A4 AWFO= NARN ;I
CPU name: [cPu31s-20P(1)
WP address: [z =] |wiork memary 128 KE; 0.4 msso00

instructions; MPI+ DP connection (DP

Preview== |
P
= Back | Mext = I Finish | Cancel | Help |

Figure 12: STEP 7 wizard “New Project” — CPU

Lo Ll |

Next add the blocks you need (for the first tests and cyclic data exchange the OB1 and
OB82 is adequate).

If a module with diagnostic capability for which you have enabled the diagnostic interrupt
detects an error, it outputs a request for a diagnostic interrupt to the CPU (when entering
and outgoing event). The operating system then calls the OB82.

If OB82 has not been programmed, the CPU changes to the STOP mode. It depends on

the PLC program if there are further OB are necessary. Please refer to the ,,Online Help® of
your Step 7 for more information how to use the S7-OB.

STEP 7 Wizard: "New Project™ x|

1T which blocks do you want to add? 304
Blocks: Block Mame Symbalic Mame I i’
OB Cycle Execution
[ oB10 Time of Day Irterrugpt 0
] o811 Time of Day Interrupt 1
O op1z Time of Day Irterrupt 2
] 0813 Time of Day Interrupt 3 hd|

I_ Select Al HE-"p an QB |

’—Language for Selected Blocks

f+ STL  LAD = FED

[~ Creste with source files Presvign== |

pd

= Back

Finish Cancel | Help |

Figure 13: STEP 7 wizard “New Project” — blocks

Click next and you can give your new project a name (for example Draeger-P7xxx)



STEP 7 Wizard: "New Project™ x|

-3} what do you want to call your project? 404)
Project name: IDraeger-P?xxx |
Exizting projects: 0209780 3
0209780
OS506 _M* &, LI

Check your neswy praject in the preview.
Click "Finizh" to create the project with the dizplayed

structure.
Previeu == |
._ Dragger-Pxx Block MName Symbolic Mame I
E‘E SMATIC 300 Station Fom Cycle Execution
& Jl cPu315-20P(1) I omaz I/ Pairt Fault 1
= o_-f| ST Programi1)
----- 425 Blocks

4
= Back | [Hext = | Finizh Cancel Help

Figure 14: STEP 7 wizard “New Project” — project name

Click Finish to save your new project. Next switch from the SIMATIC Manager component
view to the “HW Config” view, by double click to “Hardware”.

QSIMATIE Manager - [Draeger-PTxxx (Component view) -- D:Projekte’,Draege~2] - |E||5|
£ File Edit Insert PLC Yiew Options ‘Window Help _ =] =]

0| 22| g,|-.|.@_||—_| 5o e (@] ] [<vorver | 2= =Em x|

[=-EP DrasgerF 7 & CPU15-20P(1)
= SIMATIC 300 Station
= [ cPuz1s2DP)
= - 57 Program(1)
~{B] Sources
----- Block .
i Double-click
“‘Hardware” to change
into the HW Config
Press F1 to get Help, | |CPSB11(MPT) 4

Figure 15: SIMATIC manager — Component View

You can insert a power supply in Slot1 of the configuration table by double click on line 1
and choosing the correct supply (e.g. PS 307 4A).




[Hw Config - [SIMATIC 300 Station (Configuration) -- Draeger-P7xxx]

1o x|

En] Station Edit Insert PLC WView Options ‘Window Help _1&| x|
D[(8-(® |5 &| e sl [@o| 3B x|

LR = ozl

. .

T — Insert power supply Find | vt i

g:zuﬁ-ZD P[1] : Profile: I Standard j

™~~~ Double-click for

=99 FROFIBLIS DP
-2 PROFIBUS-PA
=22 PROFINET ID
SIMATIC 300
SIMATIC 400

: SIMATIC PC Based Contral 300/400
-8 SIMATIC PC Station

= properties DP
al | i
=0 v
Slot todule O |Fi.|[M.|l.]0 Camment
I EEE BES7 -
2 CPU315-2DP[1) BESAY2.0[2
AR L S
3
3
5 |

Press F1 to get Help.

Device profiles for PROFIBUS-PA

3

Figure 16: HW Config

After this double-click on line X2 to choose your PROFIBUS line

Properties - DP - {R0/52.1)

General |Addresses| Operating Model Configurationl

Short Description: DP
Order Mo.:
MName:
—Interface
Type: FROFIBUS
Address: 2
MHetworked: Mo F'[operties'_‘ . |
LComment: N

Cancel |

Icha 4
x|
-]
|
=]
=
Help |

Figure 17: Properties — DP



Properties - PROFIBUS interface DP {RO/52.1) 1'

General  Parameters |

Address: IE 'l If & subnet iz selected,

the next available address iz sugoested.

Subnet:

--- ot networked - e

Froperties. .. |
[elete |

Cancel Help

Figure 18: Properties — PROFIBUS interface DP

and click “New...”

Properties - Mew subnet PROFIBUS ﬂ

General INetworkS ingsl
Mame:

57 submet ID: ID'I2D - IDDD4

Praject path: |Draeger-P3L

Storage |ocation - —

of the project: ID:\Pro|ekte\Draege 1

Lthor I

Date created: 02.05.2006 11:50:29

Last modified: 02052006 11:50:29

LComment: d

Catcel | Help |

Figure 19: Properties — New subnet PROFIBUS

Change the following adjustments if you use a Pepperl+Fuchs segment coupler. For this
click “Properties”



Properties - New subnet PROFIBUS 1'

General  Metwork Settings |

Highest PROFIBLIS %I

Address: 126 b [~ Change

Tranzmiszion Fate:

Change
Erofile:
= |~ for P+F
{ coupler
Buz Parameters. .. |
Cancel | Help |

Figure 20: Properties — New subnet PROFIBUS (for P+F coupler)

Pay attention to change the bus parameters only if you use a Pepperl+Fuchs segment
coupler as follows.

PROFIBUS{1) |

Buz Parameters |

v Tum on eyclic distribution of the bus parameters

Tslot_Init; I 4095 t_hit Tslot: 4095 t_hit
Maw Tedr I 1DDD3: t_hit Tid2: 1000 t_bit
bin. Tadr: I 223: t_bit Trdy: 22t hit
Tzet: 150 t_hit Tid1: 335 t_hit
T qui: I 03: t_hit Ttr: I B1413 t_hbit

= ERRT mz
Gap Factaor: I 103: Thr typiceally: 9058 t_hit

= 966 ms
Fietry limit: I 1 3:

W atchdog
I 121683 t_hit
= 1258.0 ms

ok | Cancel | Help |

Figure 21: PROFIBUS - bus parameters Pepperl+Fuchs segment coupler

If you use a Siemens segment coupler choose a Transmission rate of 45,45 Kbps and the
Profile DP.



Properties - PROFIBUS x|

General  Metwork Settings |

Highest PROFIBUS Options... |

Addrezs: 126 - [ Change

Transmizzion Fate:

Profile: DP
User-Defined
Bus Parameters... |
Catcel | Help |
Figure 22: Properties — New subnet PROFIBUS (for Siemens coupler)
x
Bus Parameters |

W Tum on cyclic distribution of the bus parameters
Tglot_Init; I B40  t_bit Tslot: B40 t_hit
b . Tadr: 400 t_bit Tid2: 400 t_bit
bin, Tedr: I 1 3: t_bit Trdw: 11 t_bit
Tset: I 953: t_bit Tid1: 225 t_bit
Toquic I Daﬁ t_bit Tt I 26718 t_bit

= RE7S mz
Gap Factor: I 103: Tir bypically: 1325 t_hit

= 424 ms
Retry limit; I 13:

¥ W atchdog
I R2893 t_bit
= 11638 ms
Fecalzulate |
Cancel | Help

Figure 23: PROFIBUS - bus parameters Siemens segment coupler

After you finished these adjustments you can insert the slave. Therefore choose your slave
(Draeger P7xxx) from the catalogue at the right side of the HW Config window and drop it to
the DP master system (Step 1.) and 2.) of the following fugure). Change the slave address in
the value you adjust in the slave (e.g. slave address 3).

Now choose your module (for example Analogue Input (Al) short) and drop it in Slot 1 of the
Slave (step 3.) of the following figure). After this save and compile the HW configuration.



E@Hw Config - [SIMATIC 300 Station {Configuration) -- Draeger-PTrxH] - |EI|5|

E“]Station Edit Imsert PLC Wiew Options ‘Window Help =] x|
D[(3-(2 (Bl g Bl dlal @] 2l

= Blxl

~ Save and =

. Find: o oh
PS 307 5, - Compile | oo
g§u31 5-2DP(1) Brofle:  [Standard =l
_| PROFIBUS(1): DP raaster system (1) m PROFIBLS DF

-

=% PROFIBLS-PA
B0 Actuators
D Conwerter
{:I Discrete nput
-7 Discrete Output
D 10-Systeme
{:I Sensors
(- Draeger P7000 MK,
g EPS Fieldbus Adapter
F-gg FOOVC-End.Pa
g MSPA00 1.)
- MSPa0n_1
% Mspaon1 9700 Drag..
and drop _|ﬂ \\ - NDI0OORs
3

EIE P —

|»

< |

i@ Uriversal module

,/ [ Analog Input [&1)short

:I:l (3] PTumx / ] Analag Input (4l)lang
Slat Order Humber / Designation | Address arnrment I - [l Analog nput [Alllong

7 148]Analog Input [AlJsher P P E-gg PA200

E Pasitioner 3785 v
| | B

=

Insertion passible cha .z

Figure 24: HW Config — save and translate

Now close the HW Config View and download the project to the PLC
QSIMATIE Manager - [Draeger-PTsxx (Component view) -- D:Projekte’Draege~2] o |EI|£|
@ File Edit Insert PLC ‘Wiew Options ‘Window Help _|ﬁ||5|

D[] 22| el | [0 25| o) || & [<nom> =1 %| %)= BEm| x|

(=59 DraegerP 7w [ simq data 4% OB o 0Baz
=+l SIMATIC 300 Station
= CcPUTIs-2DR)
download
Downloads current object ko the PLC. v

Figure 25: SIMATIC Manager - download

After following all commands in the windows, now your System (PLC- Slave) is in data
exchange. (Conditions: Slave Adress must be “3” and Ident-Number Selctor to manufacturer
specified). If the device is not in data exchange please check and change the slave adress
and the PROFIBUS ident number of the device.

If the PLC is in Mode “Stop”, you can start the PLC over “PLC-Diagnostics/Setting-Operating
Mode...”.
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Figure 26: SIMATIC Manager - Operating Mode

Click “Warm Restart” to restart the CPU315.
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Figure 27: Operating Mode - STOP
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Figure 28: Operating Mode — Warm Restart
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Figure 29: Operating Mode - RUN

3 Application Guide SIMATIC PDM

3.1 Necessary equipment

You need following equipment to use PDM:

- PROFIBUS PA instrument (P7xxx)

- PROFIBUS interface (e.g. CP5611 or CP5612)
- SIMATIC S7-300 (e.g. CPU315-2DP)

- DP/PA coupler (to connect your PA-device)

- SIMATIC PDM ver. 5.2 (SP1) or higher

- PC or laptop

While every effort was made to verify the following information, no warranty of accuracy or
usability is expressed or implied.

3.2 Overview

SIMATIC PDM (Process Device Manager) is a Siemens configuration software to set up
different PROFIBUS PA devices. All parameters are accessed through SIMATIC PDM and it
also provides diagnostic information.

It is possible to connect a PROFIBUS PA network using a DP/PA-coupler (transparent
network gateway) or a DP/PA-link (modular network gateway) to a PROFIBUS DP network.
The simplest solution is using a coupler; therefore this guide describes this solution.

You need the latest version of the Device Description (DD) of the P7xxx PROFIBUS PA.
In the following chapters the setting up of SIMATIC PDM and a PROFIBUS network will be
discussed.

3.3 Set the PROFIBUS DP interface card

You can use the PROFIBUS interface cards CP5611 for desktop computers or
CP5511/CP5512 for laptop computers (PCM/CIA). After installing the card in the computer
open the SIMATIC manager and click options. Choose “Set PG/PC Interface” and highlight
CP5611, CP5511 or CP5512 (MPI) and click Properties.
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Figure 30: Set PG/PC Interface

If you use a Siemens DP/PA-coupler click to profile “DP” and set the “Transmission Rate” to

45,45 kbps
x
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Figure 31: properties SIEMENS coupler

If you use a Pepperl+Fuchs segment coupler choose “User-Defined” and a “Transmission
Rate” of 93,75 kbps.
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Figure 32: properties P+F coupler

In this case you must change the bus parameters to the values of the following picture.
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Figure 33: bus parameters P+F coupler

3.4 Update the Device Description

In general SIMATIC PDM is shipped with the DD’s that were available when the software
was last released. You should make sure that your DD matches the revision number of the
actual P7xxx. We recommend updating to the latest DD as described below.

Unzip the file PDM.zip . Run the SIMATIC manager and start the Manage Device Catalog
under the Menu Options>SIMATIC PDM.



_SIMATIE Manager - [PA {Process Device Network Yiew) -- C: Programme’, SIEME 1O x|

£ Fle Edt Insert View | Options Window Help —|=] %]
Dlgml c'ﬂl ||E| L Customize... Chrl+Al+E | vlv’l %lglm] k?l
- SIMATIC PDM Define curtent P
Set PafPC Interface. .. Show Log
Display Change Log

Manage Device Catalog...
HART server

Stark: Lifelisk

Gpen protocol

Settings...

Remoyve M5 Canneckions

Starts the device catalog management. A

Figure 34: SIMATIC Manager

Then browse into the source of the unzipped DD files and select the Device type P7xxx.

x
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Communication PROFIBUS PA

Catalogposition Sensors - Gas Analysiz

Orderturnber Q0000000 h
4 I I .3

Figure 35: Device Catalog
SIMATIC PDM Manage Device Cat ﬂ

@ The selected device types were imported.

Figure 36: Message Import complete

3.5 Configuring with SIMATIC PDM

Select “FILE/NEW” to open the “New...” Window in the SIMATIC manager. Now enter the
project name (for example “Draeger-P7xxx_pdm”) and click “OK”.



Now select “VIEW/Process Device Network View” to access the “Process Device Network

View” window.

Right click networks and select “Insert New Object/PC”.

QSIMATIE Manager - [Draeger-PTxxx_pdm (Process Device Network ¥iew) -- D:%Projekte’Draeger-] - |EI|£|
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Figure 37: Insert New Object - PC
H H “ H t
Right click networks and select “Insert New Object/PROFIBUS DP net”.
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Figure 38: Insert New Object — PROFIBUS DP net
Now insert the PA device by right click onto “PROFIBUS DP net” and select “Insert New

Object/PROFIBUS PA device”.
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Figure 39: Insert New object/PROFIBUS PA device

Now edit the name. For example change it to P7xxx.

SIMATIC PDM Insert Object(s)

Hame: [P?xxx

Address: 126

Initial value "PROFIBUS DP/PA-adress"
[0.. 126).

I™ &utomatic subnet configuration

How many "PROFIEUS P4 device'-objects should be created?

Authorization-nfo: 0 of 4 authorized TAGs projected

o]

Cancel Select

Figure 40: Edit device name

Note that the address must match the address in the device. The factory default address is
126. The device in this manual has the PROFIBUS address 3.

Then click OK. The “Process Device Network View” window will be re-open.
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Figure 41: “Process Device Network View” window

Double Click to “P7xxx”. Go to “Sensors/Gas Analysis/Draeger” and select the instrument
you are using (e.g. P7xxx). Then click “OK” to proceed. This step is only at the first time
neccesary. If have choosen a device before, you can continue with figure 40.

Select your device

Figure 42: SIMATIC PDM Device Selection
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Select “specialist” and click “OK”.
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Figure 43: User window
The SIMATIC PDM window opens as follows.

F SIMATIC PDM - PTxxx
File Device Wew Options Help

0 &f sl 5

SN[

-1l Paoc Parameter | Value | unit | Status | Name in DD =]
EI[:‘ L PTxxx
B[ Identification
i i.[Z7 Operation Unit » _Identification Tab_s_ident
[ Device » w» Operation Unit Tah_s_ident_opunit
(27 Fieldbus TAG ‘P?’xxx Loaded phys_tag_desc
[ Cerfiguration » » Device Tab_s _ident_device
[—T' Input Manufacturer Draeger Loaded phys_device_man_id
-7 Measurand 1 n )
7] Measuring Rangs 1 Product designation P Loaded phys_device_id
-7 output Device Serial Mum P-EC7000 Loaded phys_device_ser_num
=27 Analog Input Function Block 1 | Software Ravision 1 Loaded phys_software_rev
{7 Batch Information Harchware Revision 1 Loaded phys_hardware_rev
L Process value Scale Prafile Revision 301 Loaded phys_hlk_profile_rew
{27 Oukput scale R
3 Output Limits Static Revision Mo 2 Loaded phys_st_rev
{23 Human Inkerface PROFIEUS Ident Mumber Manufacturer specific Loaded phys_ident_number
» » Fieldbus Tah_s_ident_device specific
Sy version Fieldbus mod| 1.2 Loaded phys_fieldbus_module_sw_versio
H¥Y version Fieldbus mod| 1.0 Loaded phys_fieldbus_module_hw_versio
Faolytron Module Software 7.7 Loaded phys_polytron_sw_version -
» » Configuration Tab_s_ident_conf
Device Configuration Loaded phys_analysis_device_configurati
Initialization State Run Loaded phys_analysis_init_state
Device State Run Loaded phys_analysis_device_state
Global Status Ok Loaded phys_analysis_global_status
» Input Tab_s_input
» » Measurand 1 Tab_s trans1_analysis
Static Revision Mo. 8 Loaded trans1_st_rev
Marne Loaded trans1_analysis_component_nam
Unit special Loaded trans1_analysis_unit
Unit Text ppm Loaded trans1_analysis_unit_text
Sensor temperature unit | Degree celcius Loaded trans1_secondary value_unit
Active Range Range 1 Loaded trans1_analysis_active_range
Autoratic Range Choice | Off Loaded trans1_analysis_autorange_on
Sarpling Rate 0 ms Loaded trans1_analysis_sampling_rate
Mumber of Ranges 1 Loaded trans1_analysis_number_of range Ll

Display...

Bpecialst [Connected [ UM [
Figure 44: parameters SIMATIC PDM

Click “View Display” button to connect to the instrument and display real time information. It
shows the actual value of the sensor.
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Figure 45: Display — Analog Input Block 1
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Figure 46: Display — Sensor temperature

3.6 Viewing and Editing Parameters with SIMATIC PDM

The parameters used to operate the device are accessed through the folder tree in the left
pane of the “Project Manager” window. It provides full access to the parameters of the

instrument and to PDM features. The features are accessed through the “Project Manager”
window menu bar.

Device parameters:
- active fields are white, static fields are grey
- whenever possible use dropdown arrows to select values

- use upload and download buttons to change device settings and to store accumulated
application data
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Figure 47: SIMATIC PDM — device parameters

You can view Device Status...
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Figure 48: choose Device Status
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Figure 49: Device Status

... or over the menu Set Address... you can change the slave address...
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Figure 50: choose Set Adress
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Figure 51: Set Slave Address...

...or you can view online informations about the sensor and the instrument.
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Figure 52: choose Sensor Information
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Figure 53: Information — Sensor
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Figure 54: choose Instrument Information

x
Pump | Alams Eror Status | Transmitter modules |
o S ] o L L —
E2 [0 | £a[oo | 6 00 | e [0 |
o 00 | w [o0 | s [o0 | Ea [0o |
w2 [00 | wa[oo | w00 | w00 |
) o o — —

Figure 55: Information — Instrument
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Figure 56: Information — Instrument
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3.7 SIMATIC PDM LifeList

PDM Lifelist gives you immediate access to the instruments connected to your terminal. You
can monitor the settings. Also you can change the parameters of a device, but this changes
will not be reflected in the instrument’s permanent project file.

To start the LifeList select in your SIMATIC program folder Step 7 and click SIMATC PDM
LifeList .
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Figure 57: SIMATIC PDM LifeList — Start Window

Click “OK” to open the access window and click “Get LifeList”.
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Figure 58: SIMATIC PDM LifeList

Now you can see all reachable stations and devices. To get more information about one

device right-click on it.

Properties of DP station at address 3
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Figure 59: Properties of DP station



4 Installation Requirements PROFIBUS PA

4.1 PROFIBUS

PROFIBUS is a vendor-independent, open field bus standard for a wide range of
applications in manufacturing and process automation. Vendor-independence and
openness are ensured by the international standards IEC 61158 and IEC 61784.
PROFIBUS allows communication between devices of different manufacturers without any
special interface adjustment.

PROFIBUS can be used for both high-speed time critical applications and complex
communication tasks.

The PROFIBUS communication is specified in IEC 61158 Type 3 and IEC 61784. IEC
61158 Type 3 includes the entire range of PROFIBUS, consisting of the versions DP-VO0,
DP-V1 and DP-V2. IEC 61784 specifies the properties of the Communication Profile Family
CPF 3, which is PROFIBUS.

The Documents can be purchased from the IEC Website.

4.2 Introduction

For a detailed explanation look into the PROFIBUS guideline 2.092 (PROFIBUS PA — user
and installation guideline).

PROFIBUS PA is using the special physical layer according to the standard IEC 61158-2,
clause 21.

We recommend the set-up of a PROFIBUS-PA network in the hazardous area conforming
to PTB’s FISCO model. For this purpose, all the electrical components to be connected
(including the bus termination) must be approved in conformance with the FISCO model.
MBP type transmission technology ("Manchester Coding" and "Bus Powered") is a new
term that replaces the previously common terms for intrinsically safe transmission such as
"Physics in accordance with IEC 61158-2", "1158-2", etc. The reason for this change is that,
in its definitive version, the IEC 61158-2 (physical layer) describes several different
connection  technologies, MBP  technology being just one of them.
MBP is synchronous transmission with a defined transmission rate of 31.25 Kbit/s and
Manchester coding and frequently used in process automation as it satisfies the key
demands of the chemical and petrochemical industries for intrinsic safety and bus power
using two-wire technology. [Source: PNO]

4.3 Bus cable

The statements of FISCO model only apply if the bus cable in use complies with the
following specifications: R'=15...150 Ohm/km; L"=0.4...1 mH/km; C'=80...200 nF/km.

4.4 Shielding and grounding

For optimum system electromagnetic compatibility it is very important that the bus cables
connecting the components, are shielded and that these shields provide an electrical shield,
which is as complete as possible.

This means for use in non-hazardous-systems that the cable shield must be grounded as
often as possible.

In hazardous systems, adequate equipotential bonding should be provided in the hazardous
and non-hazardous areas throughout the whole field bus installation.

The use of twisted and shielded cables is urgently recommended, since otherwise the
requirements for industrial devices relating to “EMC” cannot be assured.



Note the following points on handling the shielding:

* always use metal clamps to mount shielding braid. The clamps must contact a large area
of the shielding and provide appropriate contact force.

« directly behind the cabinet's cable entry, terminate the shielding on a shielding bus. Then,
route the cable to the module; however, do not connect the shielding once again to ground
in this place.

* in installations outside of cabinets (e.g. for wall-mounting) you can also terminate the
shielding on a cable duct.

4.5 Line termination

Line termination of the PA-side consists of one capacitor (1uF +/-20%) and one resistor
(100 Ohm +/- 2%) in series on both ends of the bus main line.

5 Diagnostics with Step7

5.1 Introduction

You have different possibilities to use the diagnostic functions of your Step 7. You can view
information over the HW structure or directly with PDM.

5.2 HW diagnostic

By viewing the online information on the module you are able to locate the cause of a
module. An error in the user program cycle you can locate with the help of the diagnostic
buffer and the stack content.

In the overview symbols shows the error status of each module. If you double-click the faulty

module you get detailed error information. Following information you can view:

- general information on the module (e.g. order No., version, designation) and module
status (e.g. error)

- module errors (e.g. channel error) in the central /0 and DP slave

- messages from the diagnostic buffer

CPUs provides also following module status information:

- Cause of an error in the user program cycle

- cycle time (longest, shortest and last cycle)

- performance data (number of possible /IOs, memory bits, counters, timers and blocks)
- Options and utilization of MPlI communication

Details on diagnostic options in STEP 7 and procedures are found in the manual of your S7.
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Figure 61: Module Information Transmitter 1 Al (no error)
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Figure 63: Module Information P7xxx (sensor not connected)
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Figure 64: Diagnostic in Hex format (sensor not connected)

Another way for example for the modul information of the CPU direct from the SIMATIC
Manager by clicking PLC diagnostics.
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Figure 65: CPU Diagnostic from SIMATIC Manager
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Figure 66: CPU Diagnostic from SIMATIC Manager

5.3 Diagnostics with SIMATIC PDM

The diagnostics and status informations are accessed over the menu bar.
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Figure 67: Device Status (Sensor not connected)
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Figure 68: Device Status (Sensor not connected)
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Figure 69: Sensor Information (Sensor not connected)
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Figure 70: Sensor Information (Sensor not connected)

6 Cyclic Data Format

6.1 Analog Input Function Block

The Analog Input Function Block (Al) processes the measurements from the sensor and makes
them available to other function blocks in the transmitter. The output value from the Al block is in
engineering units and contains a status indicating the quality of the measurement.

The Al consists of 4 Byte process data value and 1 byte status information.
There are four states of quality of the data, an enumerated set of sixteen sub-status values for each
quality, and four states of the limits placed on the data. Limit information is generated for all status

attributes of all parameters having status.

For the meaning of the Status Byte please look at PROFIBUS-PA Profile for Process Control
Devices V3.01.

6.2 Configuration GSD

The GSD-File include following informations about the Input-Data of the Polytron P7xxx:

;:Modules for Analog Input

Module = "Analog Input (Al)short” 0x94

1

EndModule

;Modules for Analog Input

Module = "Analog Input (Al)long" 0x42,0x84 ,0x08,0x05
2

EndModule



